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This document describes how to use Microsoft Outlook to access the following Sun 
ONE Communications Servers:

• Sun ONE Messaging Server lets you send and receive e-mail, share folders 
with other e-mail users, and look up e-mail addresses in an LDAP directory.

• Sun ONE Calendar Server (with Sun ONE Synchronization 1.1 Patch 1 
software) lets you use Outlook to schedule meetings with other users, check 
their availability, and synchronize your Outlook calendar with Calendar 
Server so that you can access your calendar with a Web browser and publish it 
to other users. 

Contents
This document contains the following information:

• Required Software

• Using Outlook With Sun ONE Messaging Server

❍ Checking Your E-mail Configuration

❍ Configuring Outlook to Connect to Sun ONE Messaging Server

❍ Adding an LDAP Directory Server

❍ Using Shared Folders
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• Using Outlook with Sun ONE Calendar Server

❍ Installing Sun ONE Synchronization 1.1 Patch 1

❍ Configuring Sun ONE Synchronization 1.1

❍ Synchronizing With Outlook in Quiet Mode

❍ Configuring Outlook Free/Busy Options

❍ Using the Free/Busy Option to Schedule a Meeting or Appointment

❍ Syncing Outlook and Calendar Server Data

❍ Outlook and Calendar Server Usage Considerations

Required Software
To use the features described in this document, you need Outlook 98 or 
Outlook 2000. 

No other Windows software is required to use the e-mail features described under 
Using Outlook With Sun ONE Messaging Server. 

To use the features described under Using Outlook with Sun ONE Calendar 
Server, you must have the following software installed on your Windows 
computer:

• Sun ONE Synchronization 1.1 Patch 1 software. See Installing Sun ONE 
Synchronization 1.1 Patch 1.

• Microsoft Web Publishing Wizard, which is available free from Microsoft. See 
Web Publishing Wizard.

NOTE To use the features described in this document, your site must be 
running the Sun ONE Calendar Server 5.1.1 hf1.3 (or later) hotfix. If 
you have questions about Calendar Server, contact your system 
administrator.



Using Outlook With Sun ONE Messaging Server

Using Outlook With Sun™ ONE Communications Servers 5

Using Outlook With Sun ONE Messaging Server
You can use Outlook to connect to Sun ONE Messaging Server to read and send 
your e-mail. If you wish, you can also add an LDAP directory server for Outlook to 
search for recipients when you create an e-mail message, and you can access 
shared folders from other Messaging Server users.

Checking Your E-mail Configuration
Your Outlook e-mail configuration must be set to the Internet Only option. To 
determine which configuration you have, check the About Microsoft Outlook 
dialog from the Help menu. If this dialog indicates that you are in Corporate or 
Workgroup mode, follow these steps to reconfigure your e-mail option:

1. From the Outlook Tools menu, click Options.

2. Click the Mail Delivery (or Mail Services) tab and then Reconfigure Mail 
Support... .

3. Select the Internet Only option and then click Next. 

4. On the Startup dialog box, click Yes. Outlook then shuts down.

5. Restart Outlook. During the startup, Outlook may need to access its 
installation information (such as the Office installation CD) to configure the 
Internet Only option.
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Configuring Outlook to Connect to Sun ONE 
Messaging Server
To configure Sun ONE Messaging Server, you must create an IMAP mail account:

1. From the Outlook Tools menu, click Accounts. 

Outlook displays the Internet Accounts dialog, as shown in Figure 1:

Figure 1 Outlook Internet Accounts Dialog for a Mail Server

2. Click Add and then Mail... .

3. Outlook starts the Internet Connection Wizard. Follow the steps in the wizard 
and provide this information:

❍ Your Name dialog: Your display name. For example, John Smith

❍ Internet E-Mail Address dialog: Your e-mail address for your Messaging 
Server account. For example, jsmith@sesta.com
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❍ E-Mail Server Names dialog (shown in Figure 2): Your incoming and 
outgoing e-mail servers. Enter the host name of your Sun ONE Messaging 
Server in both fields. For example, mail.sesta.com

Note In the drop-down list for the incoming mail server, you must select 
IMAP, as shown in Figure 2.

Figure 2 Outlook E-mail Server Names Dialog
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❍ Internet Mail Logon dialog: Your Account name and password. To have 
Outlook remember your password, check “Remember password”.

❍ Connection Method dialog: The method you are using to connect to the 
internet. 

If your computer is connected to a corporate network, you should usually 
select “Connect using my local area network (LAN)”. If you are not sure 
about the method, check with your system administrator.

4. To complete the configuration, click Finish.

5. If you are setting up an LDAP directory server, continue to the next section; 
otherwise, click Close in the Internet Accounts dialog.

Adding an LDAP Directory Server
You can add an LDAP directory server, such as the Sun ONE Directory Server, for 
Outlook to search for recipients when you create an e-mail message. When you 
create a message, Outlook first searches for a name in your Contacts list and then in 
the directory server. 

To add a directory server, follow these steps:

1. If necessary, open the Internet Accounts dialog by selecting Accounts... from the 
Outlook Tools menu.

2. Click Add and then Directory Service... .

3. Outlook starts the Internet Connection Wizard. Follow the steps in the wizard 
and provide this information:

❍ Internet Directory Server Name dialog: Name of the Internet directory 
(LDAP) server. Enter the host name of your Sun ONE Directory Server or 
LDAP server. For example, ldap.sesta.com
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Figure 3 Outlook Internet Directory Server Name Dialog

❍ Check E-mail Addresses dialog: Select Yes to “Do you want to check 
addresses using this directory service?”

4. To complete the configuration, click Finish.

5. After you add the directory service, select it and click Properties. 

a. On the General tab, select “Check names against this server when sending 
mail”.

b. On the Advanced tab, type the Search base for the directory server. For 
example, dc=sesta,dc=com

If you don’t know this value, request it from your system administrator.

c. Click OK to dismiss the Properties dialog.
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6. When you are finished, click Close and then restart Outlook.

If you add more than one directory service, you can set the order in which Outlook 
searches them for e-mail addresses by clicking the Set Order... button on the 
Internet Accounts dialog and moving the servers up or down.

Using Shared Folders
Sharing folders between Outlook and Sun ONE Messaging Server involves 
designating a folder to be shared in Messenger Express and then accessing it from 
Outlook. 

Messenger Express is the Web interface to Sun ONE Messaging Server. To access 
Messenger Express, enter the URL for Messaging Server in your browser’s address 
or location field. For example, http://mail.sesta.com

You can then login to Messenger Express using your LDAP user name and 
password.

1. In Messenger Express, a user designates a folder to be shared and sets the 
permissions for access to the folder. 

See Sharing a Folder in Messenger Express.

2. After you have been given permission to access a shared folder, you can access 
that folder in Outlook using either of these methods: 

❍ Small Number of Users: If your site has a relatively small number of 
e-mail users with shared folders, you can view all of the shared folders in 
Outlook and access only the ones that interest you. 

See Accessing All Shared Folders in Outlook

❍ Large Number of Users: If your site has a large number of users with 
shared folders, this list can be very long. You can limit the number of 
folders you see in Outlook by first subscribing to the folders that interest 
you in Messenger Express and then displaying only those folders in 
Outlook.

See Accessing Only Subscribed Shared Folders in Outlook
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Sharing a Folder in Messenger Express
To share a folder in Messenger Express, follow these steps:

1. Login to Messenger Express.

2. Click the Folders tab.

3. Select the folder you want to share by clicking the radio button to the left of the 
folder. 

4. From the Folder tab menu, click the Share icon.

5. On the Share Folder dialog, set the Permissions List and Permissions for the 
folder:

a. Select “Enable direct delivery of e-mail to folder” check box to deliver 
messages directly to the user’s shared folder.

b. Enter the User ID of the person with whom you want to share the folder 
and click Add. 

If you are not sure of a user ID, click the Search... button and search for the 
user by name, e-mail, user ID, or phone number. After you find a user, 
click OK (or Apply to add the user and keep searching for other users).

NOTE In the current release, to access another user’s shared folder or to 
share a folder with another user, you must both be on the same 
e-mail server.
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c. After you have added all users you plan to share folders with, set the 
appropriate permissions from the drop-down list for each user:

• Read Only. User can only view the messages in the shared folder. 

• Read and Write. User can read and edit the messages in the shared 
folder and can delete subfolders. 

• Read, Write and Manage Access. User can read and edit the messages 
in the shared folder, create subfolders under each shared folder, delete 
the subfolder, and share the folders with others. 

Note The User ID indicated by “anyone” has Permissions set to “None”. 
You can reset these Permissions if you wish. For example, you might want 
to give anyone Read Only access to a folder. 

For more information about, refer to the Messenger Express online Help. 

6. When you are finished adding users and setting permissions, click OK.

The shared folder is indicated by the Shared Folder icon (shown in Step 4).

Accessing All Shared Folders in Outlook
To access all shared folders in Outlook, follow these steps:

1. On the Outlook Bar, click the icon for the Messaging Server Inbox. For 
example:

2. If the Folder List is not displayed, click the View menu and then Folder List.

3. On the Tools menu, click IMAP Folders... .

4. If the “When displaying hierarchy in Outlook, show only subscribed folders” 
check box is selected on the IMAP Folders dialog, de-select it, and click OK.

5. Restart Outlook. 

In Shared Folders in the Folder List, Outlook displays all of the shared folders 
on your e-mail server that you have permission to access.
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Accessing Only Subscribed Shared Folders in Outlook
To access only subscribed shared folders in Outlook, you must first subscribe to 
each folders in Messenger Express:

1. Login to Messenger Express.

2. On the Folders tab, click the Subscribe icon to search for shared folders in the 
Corporate Directory that you have permission to access.

3. In the Subscribe to Shared Folders dialog box, enter the search criteria for the 
owner of the shared folder you want to subscribe to and click the Search 
button.

4. From the list of users, select the user who owns the shared folder you want to 
subscribe to and click OK. 

5. From the list of folders for the owner, select the folder(s) you want to subscribe 
to and click Subscribe. 

6. On the Folders tab, Shared Folders shows the owner’s name and the 
subscribed folder name.

7. Logout of Messenger Express.

You can now access the subscribed shared folders in Outlook: 

1. On the Outlook Bar, click the icon for the Messaging Server Inbox. For 
example:

2. If the Folder List is not displayed, click the View menu and then Folder List.

3. On the Tools menu, click IMAP Folders... .

4. If the “When displaying hierarchy in Outlook, show only subscribed folders” 
check box is not selected on the IMAP Folders dialog, select it, restart Outlook, 
and return to Step 1.
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5. On the IMAP Folders dialog, click the Query button and then OK.

In Shared Folders in the Folder List, Outlook displays only the shared folders on 
your e-mail server that you have subscribed to using Messenger Express.

Using Outlook with Sun ONE Calendar Server
You can use Sun™ ONE Synchronization 1.1 to publish information from your 
Outlook calendar so that other users can determine if you are available or busy 
before inviting you to a meeting. The Outlook Free/Busy option also allows you to 
check the availability of Calendar Server users when you schedule a meeting or 
appointment in Outlook. In addition, if you give them permission, other Calendar 
Server users who use Calendar Express can view your calendar.

Sun ONE Synchronization 1.1 can sync calendar events and tasks between Outlook 
and Calendar Server. Information is updated when you initiate a synchronization 
from Outlook by clicking Synchronize Now on the Synchronize menu or by 
clicking the Synchronize icon in the Outlook tool bar.

Privacy, of course, is important, and you can control who has access to your 
Calendar Server information. For information about controlling the access to your 
calendar, refer to the Calendar Express online help. To access this help, click the 
Help button from Calendar Express.

Web Publishing Wizard
To use the Outlook Free/Busy option, you must have the Microsoft Web 
Publishing Wizard installed on your computer. The Web Publishing Wizard allows 
you to easily publish Web pages and files to a server. It is included with various 
versions of Microsoft Windows, Office, and Internet Explorer. For example, if you 
are using Windows XP, you should already have the Web Publishing Wizard.

If you are using Windows 98 or 2000, check for the Wpwiz.exe program file to 
determine if you have the Web Publishing Wizard installed on your computer. For 
example, if your programs are installed on your C drive, check the following 
location:

C:\Program Files\Web Publish\Wpwiz.exe

Or, search for the Wpwiz.exe file using the Find or Search command from the 
Start button. 
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If you don’t have the Web Publishing Wizard on your Windows 98 or 2000 
computer, you can download it free from Microsoft:

http://www.microsoft.com/downloads/release.asp?ReleaseID=22658&area=sear
ch&ordinal=2

Installing Sun ONE Synchronization 1.1 Patch 1
You first need to install Sun ONE Synchronization 1.1 Patch 1 on your Windows 
computer. If you don’t have the installation program, request it from your system 
administrator.

Before you install Sun ONE Synchronization 1.1 Patch 1, you must first:

• Uninstall Sun ONE Synchronization 1.1 or iPlanet Synchronization 1.0, if either 
version is installed on your computer:

❍ To uninstall Sun ONE Synchronization 1.1, click Start, Programs, Sun 
ONE Synchronization, Uninstall Sun ONE Synchronization and 
follow the instructions.

❍ To uninstall iPlanet Synchronization 1.0, click Start, Programs, iPlanet 
Synchronization, Uninstall iPlanet Synchronization and follow the 
instructions.

• Have Outlook 98 or Outlook 2000 installed on your computer. If you are using 
Outlook for the first time and have just configured it, you must restart it.

Installation Steps
To install Sun ONE Synchronization, follow these steps:

1. Close all open programs, if you have not already done so.

2. Start the Sun ONE Synchronization installation program.

3. Follow the instructions in the series of installation screens:

❍ Welcome

❍ License Agreement

❍ Get Registration Information

❍ Choose Destination Location
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❍ Select Components, as shown in Figure 4. On this screen, 
make sure you check Microsoft Outlook 98 / 2000.

Figure 4 Sun ONE Synchronization Installation Select Components Screen

❍ Start Installation

4. When the installation is complete, click Finish.
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Configuring Sun ONE Synchronization 1.1
After you install Sun ONE Synchronization 1.1, you need to configure it to sync 
Outlook calendar data with Sun ONE Calendar Server 5.1.1. 

To configure Sun ONE Synchronization 1.1:

1. Start Outlook.

2. From the Synchronize menu, choose Synchronize...

3. In the left pane, click Sun ONE and then Configure.

Sun ONE Synchronization 1.1 displays the Sun ONE Translator Settings dialog, 
as shown in Figure 5.
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Figure 5 Sun ONE Translator Settings Dialog

4. On the Sun ONE Translator Settings dialog, enter the following information:

Network Settings

❍ Server: The name of your Sun ONE Calendar Server. Check with your 
system administrator if you don’t know this name.

❍ Port: The port number used by Calendar Server to send and receive Sun 
ONE Synchronization commands and data. Check with your Calendar 
Server administrator if you don’t know the port number. To use the default 
port number (80), click Default.
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❍ Use secure connection (SSL): Check this box if you want your data sent 
across a secure connection to Calendar Server. Do not check this option 
unless your are told to do so by your Calendar Server administrator.

Account Settings

❍ User name: The user name for your Calendar Server account.

❍ Password: The password for your Calendar Server account.

❍ Remember password: Click this box if you want Sun ONE Synchronization 
to remember your user name and password in subsequent syncs.

Other Settings

❍ Reminder E-mail address: The e-mail address you want Calendar Server 
reminders sent to. Reminders are not sent by e-mail if you do not enter an 
e-mail address. If you are using Outlook as your master (or main) calendar, 
see Outlook as a Master Calendar.
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Synchronizing With Outlook in Quiet Mode
In quiet mode, Sun ONE Synchronization syncs data between Outlook and your 
Sun ONE Calendar without displaying synchronization screens and dialogs. Most 
error and warning messages are also suppressed. 

Required Patch
To use quiet mode, you must have Sun ONE Synchronization 1.1 Patch 1 installed 
on your Windows computer. To determine if you have this version, click: 

Start, Programs, Sun ONE Synchronization, About Sun ONE Synchronization

The About Sun ONE Synchronization window should display “Version 1.1 
(Patch 1)”. If you do not have this version, contact your system administrator.

Exceptions to Quiet Mode
In the following situations, Sun ONE Synchronization is forced to display a dialog 
or error message:

• When you install Sun ONE Synchronization 1.1 Patch 1, Sun ONE 
Synchronization displays the Full Synchronization dialog (shown in Figure 6).

• If you have not configured your Sun ONE Calendar password in the Sun ONE 
Translator Settings dialog (shown in Figure 5), Sun ONE Synchronization prompts 
you for your password. 

• If a serious error occurs, such as the Calendar Server is down, Sun ONE 
Synchronization displays an error message.
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Figure 6 Sun ONE Synchronization Full Synchronization Dialog
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Conflict Resolution
Conflict resolution dialogs are also suppressed. Conflicts are resolved depending 
on the settings you have selected in the Conflict Settings dialog:

• “Prompt for which record to use” uses Outlook records to resolve any conflicts 
(default setting).

• “Skip the record” automatically skips any conflicts.

• “Automatically resolve conflict” automatically resolves any conflicts using 
either Outlook or Sun ONE records, depending on the value you have 
configured.

“Prompt for which record to use” is the default setting. This setting uses Outlook 
records to resolve any conflicts. If you prefer to have conflicts resolved using Sun 
ONE records, follow these steps to reconfigure the Synchronize with Outlook 
settings:

1. Start Sun ONE Synchronization by clicking:

Start, Programs, Sun ONE Synchronization, Synchronize with Outlook

2. Click the Settings button and then the Conflicts tab.

3. Check “Automatically resolve conflict” and then for Use the record in, choose 
Sun ONE in the drop-down list.

4. Click OK and then Exit.

Quiet Mode Synchronization
To synchronize with Outlook in quiet mode, use one or both of the following 
methods:

• Add Synchronize with Outlook as a Scheduled Task

• Create a Synchronize with Outlook Shortcut on Your Desktop

Add Synchronize with Outlook as a Scheduled Task
To automatically synchronize in quiet mode, you can add a Synchronize with 
Outlook task to your list of Windows Scheduled Tasks list. For example, you might 
want to synchronize every hour during each workday.
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The steps to add a task to your list of Scheduled Tasks can vary depending on the 
version of Windows you are running. If you are running Windows 2000, follow 
these steps:

1. In the Windows Control Panel, double-click the Scheduled Tasks icon.

2. Double-click the Add Scheduled Task icon. Windows 2000 displays the first 
window of the Scheduled Task Wizard. Click Next to continue. 

The Scheduled Task Wizard then displays a series of windows that prompts 
you for information about the new task:

a. For Application, choose Synchronize with Outlook. (You might need to 
scroll down to find this application.) Click Next to continue.

b. If you prefer a task name other than Synchronize with Outlook, type the 
new name. Then choose when the task should run. For example, if you 
want to run the program each day, check Daily. You can refine this value 
later. Click Next to continue.

c. Select a Start time and Start date for the task. For example, to have the task 
run on Monday through Friday, check Weekdays. Click Next to continue.

d. Specify the User name and Password of the person who will run the task 
(which is probably you). Click Next to continue.

e. Check Open advanced properties for this task when I click finish and 
then Finish. Windows displays the Advanced Properties window for the 
task. 

f. On the Advanced Properties Task tab, add the /Q parameter to the 
command in Run. For example:

C:\Program Files\Sun ONE Synchronization\xtndpc.exe /S /AN 
iPlanet /PN MSOl /Q

g. Optionally, to run the task at specific times during the day, on the 
Advanced Properties Schedule tab, click Advanced... . Then on the next 
dialog, click Repeat task and provide values for Every and Until. For 
example:

Every: 2 hours 
Until: Time: 5:00 PM

or

Every: 1 hours 
Until: Duration: 8 hours
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3. Click OK (twice) to finish the task. Your new task will now run automatically 
at the times you have specified.

After you create the Synchronize with Outlook task, you can revise its properties 
by following these steps.

1. In the Windows Control Panel, double-click the Scheduled Tasks icon.

2. Either double-click the Synchronize with Outlook icon, or right-click the 
Synchronize with Outlook icon and then click Properties.

3. Make the changes to the task’s properties.

4. Click OK to save the changes.

Create a Synchronize with Outlook Shortcut on Your Desktop
To create and configure a Synchronize with Outlook shortcut on your desktop, 
follow these steps:

1. Locate the Synchronize with Outlook shortcut (shown below):

a. Right click the Start Menu and click Open All Users.

b. Click Programs and then Sun ONE Synchronization.

c. Right click the new Synchronize with Outlook shortcut and then click 
Send To Desktop (create shortcut).

2. On your desktop, right click the new Synchronize with Outlook shortcut and 
then click Properties.

3. On the Synchronize with Outlook Properties dialog, click the Shortcut tab 
and add the /Q parameter to the xtndpc.exe Target command. For example:

"C:\Program Files\Sun ONE Synchronization\xtndpc.exe" /S /AN 
iPlanet /PN MSOl /Q

Note If you type this command, for MSOl, the MSO letters are uppercase, but the 
l letter is lowercase.

4. Click OK.

Now, to synchronize in quiet mode between Outlook and your Sun ONE Calendar, 
double-click the Synchronize with Outlook shortcut on your desktop.
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Note Synchronize Now on the Outlook Synchronize menu and the 
Synchronization Icon on the Outlook tool bar do not initiate synchronization in 
quiet mode.

Configuring Outlook Free/Busy Options
The Outlook Free/Busy option also allows you to check the availability of 
Calendar Server users when you schedule a meeting or appointment in Outlook. 
To configure this option, you will need the following information:

• URL of the server where Sun ONE Calendar Server 5.1.1 is running. For 
example: http://calendar.sesta.com. Your system administrator can 
provide you with the appropriate URL for your company.

• E-mail address of each person on Sun ONE Calendar Server you want to 
invite. For example: jsmith@sesta.com.

To configure the Outlook Free/Busy Options, follow these steps:

1. Start Outlook.

2. On the Tools menu, click Options... and then click the Calendar Options... 
button on the Preferences tab.

3. Click the Free/Busy Options button.
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4. In the Search at this URL box, enter the following URL:

http://server-name/get_freebusy.wcap?fmt-out=text/calendar&tzid=time
zone&mail=%NAME%@%SERVER%

where:

http://server-name is the fully qualified URL where Sun ONE Calendar Server 
5.1.1 is running. If Calendar Server is running on a port other than the default 
port number (80), you must also specify the port number after the server-name 
field. For example: server-name:8080. 

tzid=timezone specifies your specific time zone. For example: 
tzid=America/Chicago. For more information, see Determining a Time Zone 
(timezone) Value.

If you do not include the tzid parameter, the time for an all day event is 
shown in Zulu time, which is also known as Universal Time Coordinated 
(UTC) or Greenwich Mean Time (GMT).

For example (shown in Figure 7):

http://calendar.sesta.com/get_freebusy.wcap?fmt-out=text/calenda
r&tzid=America/Chicago&mail=%NAME%@%SERVER%

where http://calendar.sesta.com/ specifies the URL where Sun ONE 
Calendar Server 5.1.1 is running. 
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Figure 7 Outlook Free/Busy Options Dialog Box

5. Click OK to close each of the three dialog boxes.

Usage Notes
• The get_freebusy.wcap command has an underscore (_) between get and 

freebusy.wcap.

• To check the free/busy information of a Calendar Server calendar or to share 
your calendar with other users, the calendar permissions must be set to 
Availability for Everyone. If you have problems accessing another user’s 
calendar, check with the owner of the calendar to make sure the permissions 
are set correctly. 

For information about setting the permissions for a calendar, refer to the 
Calendar Express online help. To access this help, click the Help button from 
Calendar Express.

• The fmt-out=text/calendar parameter is not required if the 
service.wcap.format configuration parameter in the ics.conf file is set to 
“text/calendar”. Your system administrator can let you know the value of 
the service.wcap.format parameter.
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• To return free/busy information for all-day events created on Sun ONE 
Calendar Server, include the tzid parameter. For example: 
tzid=America/Chicago. 

If you do not include the tzid parameter, the time for an all day event is 
shown in Zulu time, which is also known as Universal Time Coordinated 
(UTC) or Greenwich Mean Time (GMT).

Determining a Time Zone (timezone) Value
To determine your specific timezone value for the free/busy URL:

1. Log into Sun ONE Calendar Express.

2. Click the Options tab and then Settings.

3. Under Time Zone, click the time-zone string after By default, display dates 
and times using the following time zone:. Calendar Express displays a 
window with the time-zone strings. 

4. Find the time-zone string for your area and copy it into the free/busy URL. For 
example, America/Chicago represents the central time zone in the United 
States.
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Using the Free/Busy Option to Schedule a 
Meeting or Appointment
To schedule a meeting or appointment in Outlook and check the availability of 
users on Calendar Server, follow these steps:

1. Start Outlook and click Calendar.

2. On the File menu, Click New and then Appointment (or press Ctrl+N).

3. Enter information such as the Subject, Location, Start time, and End time.

4. Click the Attendee Availability tab. Outlook displays the Attendee 
Availability window, as shown in Figure 8.

5. To check the availability of a Calendar Server user, enter the e-mail address of 
the user under All Attendees. For example: jsmith@sesta.com.

Or, if you have previously entered the user’s e-mail address in your Contacts 
list, enter the user’s name. For example: John Smith.

Outlook then queries Calendar Server and displays the availability of the user.

By default, Outlook shows the availability of a user for 30 days before and after 
the current date. Your system administrator, however, can configure Calendar 
Server to return different values for the duration. If you have questions about 
the duration, contact your system administrator.

6. When you have added all attendees and determined an acceptable time, click 
Send to add the appointment to your Outlook calendar and send an e-mail 
invitation to each attendee.



Using Outlook with Sun ONE Calendar Server

30  Using Outlook With Sun™ ONE Communications Servers • April 2003

Figure 8 Outlook Attendee Availability Window
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Syncing Outlook and Calendar Server Data
To synchronize calendar events and tasks between Outlook and Calendar Server, 
click Synchronize Now on the Synchronize menu or click the Synchronization 
Icon on the tool bar. 

Recommendation
To share the latest information with your colleagues, consider syncing calendar 
data between Outlook and Calendar Server when you first start Outlook and then 
before you exit. You might also want to sync after you have created events or 
appointments to keep calendar data up to date on both Outlook and Calendar 
Server.

Outlook and Calendar Server Usage 
Considerations
Considerations for using Outlook and Sun ONE Calendar Server include:

• Calendar Server Default Calendar and the Free/Busy Option

• Configuring the Free/Busy Option for Sun ONE Calendar Events

• Calendar Server Events and the Free/Busy Option

• Outlook as a Master Calendar

• Delay in Free/Busy Look-up for Calendar Server Events

• New Outlook Appointments by Dragging E-mail to Calendar Folder

Calendar Server Default Calendar and the Free/Busy Option
The Outlook free/busy time option checks events in the user's default calendar 
only. If a Calendar Server user has other calendars, those calendars are not used 
when determining the free/busy time.
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Configuring the Free/Busy Option for Sun ONE Calendar Events
To make free/busy information available for events created in Sun ONE Calendar, 
check Free/Busy Include this event in calculating availability for the event on the 
Calendar Express Edit Event window.

Calendar Server Events and the Free/Busy Option
If you are using the Outlook free/busy option, Calendar Server events (both single 
and recurring) created using Calendar Express are shown on the Outlook Attendee 
Outlook Availability tab as follows: 

• Public and Confidential (Time and Date Only) events are shown as busy. 

• Public and Confidential (Time and Date Only) all day events created in Sun 
ONE Calendar are shown in the Outlook free/busy information using the time 
zone specified by the tzid parameter in the Outlook Free/Busy Options 
dialog. For more information, see Configuring Outlook Free/Busy Options.

• Private events are not shown. (See also Outlook as a Master Calendar.)

Delay in Free/Busy Look-up for Calendar Server Events
Sometimes you might see free/busy information in Outlook that is inconsistent 
with Sun ONE Calendar. This discrepancy can occur because Outlook updates the 
free/busy information from Calendar Server only as follows: 

• When Outlook is first started (or restarted). 

• According to the time configured in the following statement on the Free/Busy 
Options dialog (shown in Figure 7): 

“Update free/busy information on the server every minutes minutes”

where minutes can be 1 to 99.

NOTE To make the Free/Busy option available in Sun ONE Calendar 
Express, the following Calendar Server configuration parameter in 
the ics.conf file must be set to “yes”:

ui.eventdialog.opaque.enable = "yes"
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Therefore, to get accurate free/busy information when you check the availability of 
a Sun ONE Calendar user, you can: 

• Exit and then restart Outlook. 

or

• Set the “Update free/busy information on the server every minutes minutes” to 
a small value such as 1 or 2 minutes and then wait that long before you update 
your free/busy information. 

Outlook as a Master Calendar
If you use Outlook as your master (or main) calendar, consider the following items:

• Private Events. If you create Private events in your Outlook calendar and then 
sync your Outlook calendar to Calendar Server, the events are synced as 
Private events. However, if another Outlook user later checks your Calendar 
Server for free/busy time, your Private events are not shown on the Outlook 
Attendee Availability tab.

• E-mail Reminders. When you scheduling event on Outlook, you might prefer 
to have Outlook send the e-mail reminder rather than Calendar Server. To 
have only Outlook send e-mail reminders, remove your e-mail address from 
the Sun ONE Synchronization Translator Settings dialog. 

New Outlook Appointments by Dragging E-mail to Calendar Folder
Outlook allows users to create new a appointment by dragging an e-mail message 
to the Calendar folder. However, since the Sun ONE Notes field is mapped to the 
Outlook Notes field, extra characters are added to the appointment description 
during a subsequent synchronization. If an Outlook user then tries to delete the 
extra characters in the description, an e-mail message is generated saying the 
meeting has been changed. 

To avoid this problem, do not create a new appointment by dragging an e-mail 
message to the Calendar folder.

Return to Contents
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